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Notice

Copyright
 Agilent Technologies 2002. All rights reserved. 

No part of this manual may be reproduced in any form or 
by any means (including electronic storage and retrieval 
or translation into a foreign language) without prior 
agreement and written consent from Agilent Technologies 
Inc. as governed by United States and international 
copyright laws. 

Notice
The material contained in this document is subject to 
change without notice. Agilent Technologies makes no 
warranty of any kind with regard to this material, 
including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose. 
Agilent Technologies shall not be liable for errors 
contained herein or for incidental or consequential 
damages in connection with the furnishing, performance, 
or use of this material. 

Warranty
This Agilent Technologies product has a warranty against 
defects in material and workmanship for a period of three 
years from date of shipment. During the warranty period, 
Agilent Technologies will, at its option, either repair or 
replace products that prove to be defective. For warranty 
service or repair, this product must be returned to a 
service facility designated by Agilent Technologies. The 
Buyer shall pay Agilent Technologies round-trip travel 
expenses. For products returned to Agilent Technologies 
for warranty service, the Buyer shall prepay shipping 
charges to Agilent Technologies and Agilent Technologies 
shall pay shipping charges to return the product to the 
Buyer. However, the Buyer shall pay all shipping charges, 
duties and taxes for products returned to Agilent 
Technologies from another country. 

Agilent Technologies warrants that its software and 
firmware designated by Agilent Technologies for use with 
an instrument will execute its programming instructions 
when properly installed on that instrument. Agilent 
Technologies does not warrant that the operation of the 
instrument software, or firmware, will be uninterrupted or 
error free.

Limitation of Warranty    
The foregoing warranty shall not apply to defects resulting 
from improper or inadequate maintenance by the Buyer, 
Buyer-supplied software or interfacing, unauthorized 
modification or misuse, operation outside of the 
environmental specifications for the product, or improper 
site preparation or maintenance. No other warranty is 
expressed or implied. Agilent Technologies specifically 
disclaims the implied warranties of merchantability and 
fitness for a particular purpose.

Exclusive Remedies    
The remedies supplied are the Buyer's sole and exclusive 
remedies. Agilent Technologies shall not be liable for any 
direct, indirect, special, incidental, or consequential 
damages, whether based on contract, tort or any other 
legal theory.

Certification 
Agilent Technologies certifies that this product met its 
published specifications at the time of shipment. Agilent 
Technologies further certifies that its calibration 
measurements are traceable to the United States Institute 
of Standards and Technology, to the extent allowed by the 
Institute's calibrating facility, and to the calibration 
facilities of other International Standards Organization 
members.

Services and Support
Any adjustment, maintenance, or repair of this product 
must be performed by qualified personnel. Contact your 
customer engineer through your local Agilent 
Technologies Service Center. You can find a list of local 
service representatives on the Web at:

http://www.agilent.com/Service/English/index.html

Safety Summary
The following general safety precautions must be 
observed during all phases of operation of this instrument. 
Failure to comply with these precautions or with specific 
warnings elsewhere in this manual violates safety 
standards of design, manufacture, and intended use of the 
instrument. Agilent Technologies Inc. assumes no liability 
for the customer's failure to comply with these 
requirements.

General
This product is a Safety Class 1 instrument (provided with 
a protective earth terminal). The protective features of this 
product may be impaired if it is used in a manner not 
specified in the operation instructions.

All Light Emitting Diodes (LEDs) used in this product are 
Class 1 LEDs as per IEC 60825-1.

Environmental Conditions
This instrument is intended for indoor use in an 
installation category II, pollution degree 2 environment. It 
is designed to operate at a maximum relative humidity of 
95% and at altitudes of up to 2000 meters. Refer to the 
specifications tables for the ac mains voltage requirements 
and ambient operating temperature range.

Before Applying Power
Verify that the product is set to match the available line 
voltage, the correct fuse is installed, and all safety 
precautions are taken. Note the instrument's external 
markings described under “Safety Symbols” on page 8.

Ground the Instrument
To minimize shock hazard, the instrument chassis and 
cover must be connected to an electrical protective earth 
ground. The instrument must be connected to the ac 
power mains through a grounded power cable, with the 
ground wire firmly connected to an electrical ground 
(safety ground) at the power outlet. Any interruption of 
the protective (grounding) conductor or disconnection of 
the protective earth terminal will cause a potential shock 
hazard that could result in personal injury.

Safety Symbols 

In the manuals:

WARNING

Warnings call attention to a procedure, practice, or the 
like, which, if not correctly performed or adhered to, could 
result in personal injury or loss of life. Do not proceed 
beyond a Warning until the indicated conditions are fully 
understood and met. 

CAUTION

Cautions call attention to a procedure, practice, or the 
like, which, if not correctly performed or adhered to, could 
result in damage to or destruction of part or all of the 
equipment. Do not proceed beyond a Caution until the 
indicated conditions are fully understood and met.

Cleaning Recommendation

WARNING

To prevent electrical shock, disconnect the instrument 
from mains before cleaning. Use a dry cloth or one slightly 
dampened with water to clean external case parts. Do not 
attempt to clean internally.

Documentation History
All Editions and Updates of this manual and their creation 
date are listed below. The first Edition of the manual is 
Edition 1. The Edition number increments by 1 whenever 
the manual is revised. New Editions are complete 
revisions of the guide reflecting alterations in the 
functionality of the instrument. Updates are occasionally 
made to the guide between editions.

Edition 1.0 March 2001

Edition 1.1 July 2001

Edition 1.2 December 2001

Edition 1.3 April 2002

Trademarks
Portions of this documentation have been licensed from 
Computer AccessTechnology Corporation (CATC). 
Computer Access Technology Corporation(tm), 
CATC(tm), the CATC Logo and BusEngine(tm) are 
trademarks of Computer Access Technology Corporation. 
Microsoft ®, Windows NT ®, Windows ® and MS 
Windows ® are U.S. registered trademarks of Microsoft 
Corporation. All other brand and product names are 
trademarks or registered trademarks of their respective 
companies.

Agilent Technologies

Herrenberger Straße 130
D-71034 Böblingen
Germany 

Parts of the instrument marked 
with this symbol are subject to 
damage by static electricity. In 
order to protect against 
electrostatic discharge to the 
instrument use static-free work 
stations.

Caution (refer to accompanying 
documents)

Protective earth (ground) terminal 
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Overview

The Agilent E2951A/E2952A Analyzer for InfiniBand is the newest 
member in Agilent Technologies’ industry-leading line of high 
performance protocol analyzers. 

The Agilent E2951A/E2952A Analyzer for InfiniBand is an ideal tool to 
analyze InfiniBand link data. Development Engineers will rely on the 
Analyzer for InfiniBand to resolve software, firmware and hardware 
problems encountered in the development of InfiniBand devices, host 
channel adapters and switches. Using the Analyzer for InfiniBand, Test 
and Quality Assurance Engineers will verify correct operation of 
InfiniBand products as well as compliance to the standard. In addition to 
these applications, anyone involved with the InfiniBand standard will use 
the Analyzer for InfiniBand Application as a stand-alone viewer to 
understand the InfiniBand protocol and to facilitate system level 
discussions and problem resolution of applications employing InfiniBand 
technology.
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Overview General Description
Please refer to the InfiniBand Specification, version 1.0a for details on 
the InfiniBand protocol. The InfiniBand specification is available from 
the InfiniBand Trade Association at its Web site 
http://www.infinibandta.org/

General Description 

The Agilent E2951A/E2952A Analyzer for InfiniBand is a hardware unit 
for analyzing InfiniBand link data. Once installed, the Analyzer for 
InfiniBand can be easily configured and controlled by a portable or 
desktop PC connected via its USB port.

The Analyzer for InfiniBand is a non-intrusive testing tool for the 
InfiniBand protocol providing traffic capture and analysis. Hardware 
triggering allows real-time events to be captured. Hardware filtering 
allows the different types of packets to be filtered in or out of the 
recording. Filtering allows users to focus recordings on events of interest 
and to preserve recording memory so that the recording time can be 
extended.

Recorded data is presented in colored graphics in a trace viewer 
application. This application has advanced search and viewing 
capabilities that allow the user to quickly locate specific data, errors and 
other desired conditions, thereby focussing the user’s attention on 
events of interest. 

Analyzer PC Requirements

The Analyzer for InfiniBand functions with any personal computer that 
meets the following requirements: 

Please ensure that your PC complies with these requirements:

• Microsoft Windows 98®, Windows ME®, Windows 2000® or 
Windows XP®for recording and viewing traffic
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Analyzer PC Requirements Overview
NOTE On Windows NT® systems, only demo/offline mode is possible.

• At least 20 MB hard disk space, plus additional memory for recordings 
(as much as 800 MB when recording a full buffer size)

• Equipped with a USB port 2.0

All communications between the PC and the Analyzer is passed 
through a USB cable.  If the PC is being used only as a trace viewer, 
the USB port is not necessary.

• Physical RAM of at least 128 MB

The amount you use should be double the amount of your largest 
recording — for example, if you plan to make 512 MB recordings, then 
your PC should have at least 1024 MB RAM.

• Monitor resolution at least 800x600 with thousands of colors
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Overview Configuration and Controlling
Configuration and Controlling

The E2951A/E2952A Analyzer for InfiniBand is controlled from a 
personal computer USB port across a USB connection.

The Analyzer for InfiniBand provides on-the-fly detection of and 
triggering on such events as Packet Headers and Errors. Whether 
recording manually or with a specified trigger condition, the Analyzer for 
InfiniBand continuously records the link data in a wrap-around fashion 
until manually stopped or until the trigger event is detected and a 
specified post-trigger amount of link data is recorded.

Upon detection of a triggering event, the E2951A/E2952A Analyzer for 
InfiniBand continues to record data up to a point specified by the user. 
Real-time detection of events can be individually enabled or disabled to 
allow triggering on events as they happen. This includes predefined 
exception or error conditions and a user-defined set of trigger events.
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Features Overview
The Analyzer for InfiniBand software provides powerful search functions 
that enable investigation of particular events and allow the software to 
identify and highlight specific events. In addition to immediate analysis, 
you can print any part of the data. Use the Save As  feature to save the 
data on disk for later viewing. The program also provides a variety of 
timing information and data analysis reports.

Features

The E2951A/E2952A Analyzer for InfiniBand provides a lot of useful 
hard- and software features.

General
The general features of the Analyzer for InfiniBand are:

• Upgradeable firmware and recording engine

• Software operates stand-alone on any Microsoft Windows 98 or later 
computer as a “Trace Viewer”

• Link and data packets are displayed and fully decoded

• 10b encoding as reference for every packet

• Training sequences are displayed

• Transport level functions are fully decoded with a graphical 
illustration of the comprised packets and messages

• Errors at the physical, link and transport levels are highlighted in red

• On-line and context sensitive help

• The E2951A/E2952A can be administered by any desktop or portable 
Microsoft Windows-based computer with USB capability
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Overview Features
Physical Components
The E2951A/E2952A Analyzer for InfiniBand provides the following 
physical components:

• The Analyzer for InfiniBand unit

• Convenient Plug-and-Play USB installation

• Taps non-intrusively between two 2.5 Gbit/sec for the E2951A or 
10 Gbit/sec for the E2952A InfiniBand ports using two standard cables

• External interface for probing and monitoring auxiliary digital signals 
and for cross triggering between other test instruments

Recording Options
The Analyzer Software can record InfiniBand data, timing and control 
information. The E2951A can store up to 512 MB, the E2952A up to 2 GB. 
Additionally, the software provides the following features:

• Three recording modes: snapshot, manual trigger, and event trigger

• Selectable recording buffer size and trigger position

• Record the full data rate of a single 1x, 2.5 Gbit/sec (E2951A) or 4X, 10 
Gbit/sec (E2952A) InfiniBand link

• Trigger on InfiniBand conditions like link training sequences or cable 
disconnect events

• Trigger on a comprehensive list of error conditions like running 
disparity, bad packets or bad variant or invariant CRCs

• Trigger on a sequence of packets to capture messages and transport 
level events

• Programmable triggering based on bit-wise pattern matching of 
InfiniBand headers and data payloads

• Optionally filter captured data or truncate long data payload
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Features Overview
Display Options
The Display Options offer various settings and features:

• Extensive use of color and graphics within the trace

• Packet errors and protocol violations are highlighted in red

• Skip ordered sets between packets are counted and an error marked 
when they are missed

• Packet color clearly indicates position before or after the trigger point

• Packets can be marked with text annotations that become tool-tips for 
future reference

• Tool-tips with complete definitions of most fields

• Search, show or hide only the data of interest using InfiniBand-
specific criteria

• Packets are accurately time-stamped (1 symbol time or 4 ns 
resolution)

• Measure time, throughput or responsiveness between packet markers 
or relative to the trigger position

InfiniBand BusEngine 
The BusEngine™ Technology is at the heart of the new Analyzer for 
InfiniBand. The revolutionary BusEngine core uses state-of-the-art 
Electrically Programmable Logic Device (EPLD) technology and 
incorporates both the real-time recording engine and the configureable 
building blocks that implement data/state/error detection, triggering, 
capture filtering, external signal monitoring and event counting and 
sequencing. Like the flash-memory-based firmware that controls its 
operation, all BusEngine logic is fully field upgradeable. You can 
download the newest configuration files and software from the Agilent 
Technologies Web site (www.agilent.com/find/infiniband ).
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Overview Features
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Getting Started with the Analyzer for 
InfiniBand

In this chapter you will learn how to install and use the Analyzer for 
InfiniBand and its software. You will also record your first InfiniBand 
data.

Quick Installation

The Analyzer for InfiniBand is easily installed on most Windows-based 
personal computer systems. You can begin making InfiniBand™ 
recordings after following these initial steps. However, if you are unsure 
about what to do after reading the Quick Installation instructions, or if 
your analyzer does not work after you follow these instructions, read 
through the subsequent sections in this manual.
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Getting Started with the Analyzer for InfiniBand Quick Installation
Setting Up the Analyzer
To set up the Analyzer for InfiniBand please follow these steps:

1 Remove the Analyzer for InfiniBand from its shipping container.

2 Connect the AC power cable to the rear of the unit.

3 Turn on the power switch on the rear of the Analyzer.

4 Insert the Analyzer CD-ROM into the PC that will be controlling the 
Analyzer.

5 Connect the USB cable between the USB port on the back of the 
Analyzer and a USB port on the PC.

NOTE The USB port on the host PC must be at least a USB 1.1 port. A USB 
2.0 port is recommended. 

6 Follow on-screen plug-and-play instructions for the automatic 
installation of the Analyzer for InfiniBand as a USB device on your 
analyzing PC (the Analyzer for InfiniBand CD-ROM includes the 
required USB files).

Installing the Software
After the Analyzer for InfiniBand is set up correctly you can install the 
software:

1 Run the program d:\setup  (where d:\  represents the CD drive) and 
follow the on-screen instructions to install the Analyzer for InfiniBand 
application on the analyzing PC’s hard disk.

2 To start the application, launch the Agilent Technologies Analyzer for 
InfiniBand program from the Start Menu: 

Start > Programs > Agilent->Agilent E2951A-E2952A Analyzer for 

InfiniBand .
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Quick Installation Getting Started with the Analyzer for InfiniBand
Your First InfiniBand Recording
After installing and launching the software, you can test the Analyzer for 
InfiniBand by performing the following steps:

1 Plug in an InfiniBand cable to each of the two ports on the 
E2951A/E2952A unit, then connect the other ends to the device under 
test.

NOTE The USB port on the host PC must be at least a USB 1.1 port. A USB 
2.0 port is recommended. 

2 Select Recording Options under Setup on the menu bar.

3 Select the General tab.

The following dialog box opens showing factory default settings such 
as Snapshot and 4 MB buffer size. For your first recording, you can 
leave these settings unchanged.

4 Click OK to activate the recording options you selected.

5 Turn on the InfiniBand devices that are to be tested and cause them to 
generate InfiniBand traffic.
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Getting Started with the Analyzer for InfiniBand Quick Installation
6 Click  on the tool bar.

Analyzer for InfiniBand starts to record the InfiniBand traffic 
immediately. After 4 Mbytes of traffic is recorded, the analyzer will 
upload the data and display the packets in the trace window.

7 If you wish to terminate the recording before the snapshot 
automatically completes, click  on the Tool Bar.

When the recording session is finished, the traffic is uploaded from the 
Analyzer to the hard drive on your PC as a file named data.ibt  or 
whatever name you assigned as the default filename. While the file is 
being uploaded, you should see a white progress bar at the bottom of 
the screen. When the bar disappears, it indicates that the data has 
been uploaded to disk.

8 To save a current recording for future reference:

Select Save As under File on the Menu Bar.

- or -

Click  on the Tool Bar.

You see the standard Save As dialog box.

9 Give the recording a unique name and save it to the appropriate 
directory.
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Quick Installation Getting Started with the Analyzer for InfiniBand
Capturing Your First InfiniBand Trace
After a few moments, the recording will terminate and the results will be 
displayed. 
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Getting Started with the Analyzer for InfiniBand Detailed Installation
Detailed Installation

If you want to know more about the installation and configuration of the 
Analyzer for InfiniBand you can get into details here.

System Components/Packing List
The Analyzer for InfiniBand package includes:

• One stand-alone Analyzer for InfiniBand module

• One 6-foot (2-meter) USB cable

• Two InfiniBand cables with the E2951A, only one with the E2952A.

• One Breakout Board with the E2952A

• Analyzer for InfiniBand software program installation CD-ROM

• Product documentation
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Detailed Installation Getting Started with the Analyzer for InfiniBand
The Analyzer for InfiniBand Unit
This section provides descriptions of the E2951A/E2952A’s front and rear 
panel elements.

Elements of the Front Panel
If you look at the front panel, you will see LEDs, buttons and connectors.

Left-most LEDs There are two LEDs on the left-most side of the front panel:

• Green POWER indicator LED lights when the unit power is switched 
on.

• Red Status indicator LED lights during the boot up.
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Getting Started with the Analyzer for InfiniBand Detailed Installation
LEDs and Button beneath the
Connectors

The LEDs and button beneath the connectors on the front side show the 
status of the E2951A/E2952A unit:

• Green RECORD LED lights when the unit is recording.

• Orange TRIGGER LED lights when the unit triggers an event.

NOTE The orange Trigger LED under the right module slot also lights during 
power-on testing and will be turned off at the end of the power-on 
cycle. If the LED blinks at the end of this cycle, the hardware is faulty.

• Green UPLOAD LED lights when unit is uploading data to PC.

• MANUAL TRG push-button allows a manual Trace capture.

Connectors In the upper front area of the E2951A/E2952A the following elements are 
placed:

• Two InfiniBand connectors 

• Green Active LED lights when the E2951A/E2952A is activated.

After beginning a recording session, press the MANUAL TRG switch to 
force a Trigger condition. The session completes when a specified post-
trigger amount of link data is recorded or when you manually stop a 
recording session. 
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Detailed Installation Getting Started with the Analyzer for InfiniBand
Elements of the Rear Panel
If you look at the rear panel, you will see the following ports and 
connectors:

• Wide-range AC connector module

– Power socket

– Power on/off switch

• USB port

• External Interface Breakout Board connector

DB-25 (25-pin) external interface connector

• External input

• External output

WA RNING Do not open the unit enclosure. There are no operator serviceable parts 
inside. For servicing, refer to Agilent Technologies.

WA RNING For prevention of ESD influence in measurements, setups with the 
E2951A/E2952A connected to data generators by signal lines must be 
performed in an ESD-protected environment.
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Getting Started with the Analyzer for InfiniBand Detailed Installation
Analyzer for InfiniBand System Setup
The Analyzer System for InfiniBand is connected and controlled by a 
desktop or laptop PC via a USB connection. 

To set up the system hardware:

1 Connect the Analyzer to an AC power source.

2 Connect to the analyzing PC via USB 2.0.

3 Connect InfiniBand cables to the devices under test.

AC Power Source
The instrument can operate from any single-phase AC power source 
supplying 100-240 V in the frequency range from 50 to 60 Hz.

Use the power switch located on the rear panel to turn the analyzer unit 
on and off.

NOTE At power-on, the analyzer initializes itself in approximately 25 seconds 
and performs an exhaustive self-diagnostic that lasts about 45 seconds. 
The Status LED illuminates during the power-on testing and turns off 
when testing is finished. If the diagnostics fail, the Status LED blinks, 
indicating a hardware failure. If this occurs, call Agilent Technologies 
Customer Support for assistance.

PC Connection
Use the USB cable that was provided to connect the host computer to the 
E2951A/E2952A.
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Detailed Installation Getting Started with the Analyzer for InfiniBand
Analyzer for InfiniBand Program 
Installation
The Agilent E2951A/E2952A Analyzer for InfiniBand software is provided 
on CD-ROM and requires a Windows 98®, Windows ME®, Windows 
2000® or Windows XP® operating system. If you are installing the 
Analyzer for InfiniBand software on a Windows NT® computer, you will 
only be able to run in demo/offline mode (that is, you can use the 
computer to view, analyze, and print data that was collected and saved 
on another system even if it does not have an Analyzer attached).

Loading the Analyzer for InfiniBand USB Drivers
The USB drivers have to be installed to enable the communication 
between the Analyzer for InfiniBand and the PC. For installation please 
follow these steps:

1 Insert the Analyzer for InfiniBand CD-ROM into the PC.

2 Power on the Analyzer for InfiniBand.

3 Connect the USB cable to the rear of the Analyzer and to the PC. 

The host operating system detects the Analyzer and begins to install 
the USB driver.

NOTE When Windows prompts you for a file, browse to the Agilent CD-ROM in 
the CD-ROM drive.

Installing the Analyzer for InfiniBand Application 
Program 
Run Setup.exe  from the Analyzer for InfiniBand CD-ROM. 

The Agilent E2951A/E2952A Analyzer for InfiniBand Install Wizard 
automatically installs the necessary files to the computer’s hard drive. 
The Analyzer for InfiniBand software is installed in the C:\Program

Files\Agilent\ E2951A/E2952A 1x Analyzer for InfiniBand directory 
unless you specify otherwise. Follow the installation instructions on 
your screen.
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Getting Started with the Analyzer for InfiniBand Detailed Installation
Analyzer for InfiniBand Program Startup
You can start the Analyzer for InfiniBand program from the Desktop or 
from the installed directory. The program always begins with its main 
screen active:

The software may be used with or without the E2951A/E2952A. When 
used without the E2951A/E2952A, the program functions in a Trace 
Viewer mode to view, analyze, and print captured protocol traffic.

When the program is used, and the Analyzer for InfiniBand is attached to 
the computer, you can set trigger conditions, record, monitor and 
analyze the activity of your InfiniBand device or fabric.
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Making a Recording Getting Started with the Analyzer for InfiniBand
Making a Recording

After installation, the software is configured to make a Snapshot 
recording of InfiniBand traffic.

Start Recording To make your first recording of this traffic:

1 Connect InfiniBand cables to both InfiniBand connectors on the front 
panel of the E2951A/E2952A module and plug the other ends into the 
device under test.

2 Cause the device under test to generate InfiniBand traffic.

3 Click  on the Tool Bar.

After 4 Mbytes of traffic is recorded, the analyzer will upload the data 
and display the packets.

Terminate Recording 4 To terminate recording before Inquiry time-out occurs:

Click  on the Tool Bar at any time before recording automatically 
terminates.

When the recording session is finished, the traffic is saved to the hard 
drive as a file named data.ibt or whatever name you assign as the 
default filename.

Save Recording 5 To save a current recording for future reference:

Select Save As under File on the Menu Bar.

- or -

Click  on the Tool Bar.

You see the standard Save As dialog box.

6 Give the recording a unique name and save it to the appropriate 
directory.
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Updating the E2951A/E2952A Analyzer 
for InfiniBand

From time to time as modifications are made to the Analyzer for 
InfiniBand, it is necessary to update the Analyzer for InfiniBand for 
optimal performance. Updates can be performed two ways: either 
automatically or manually. This chapter describes both procedures.

How to Get the Latest Software, 
Firmware, and BusEngine 
Revisions

The Readme.txt file on the installation CD-ROM and in the installed 
directory gives last-minute updates about the current release. Included 
with each release are the most recent downloadable images of the 
firmware and the BusEngine. The Readme.txt  file lists the latest versions 
and informs you if new firmware or a new BusEngine needs to be 
updated in your hardware.
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Updating the E2951A/E2952A Analyzer for InfiniBand How to Get the Latest Software, Firmware, and BusEngine
Revisions
Once the Analyzer has completed the self diagnostics and is connected to 
the PC, you can check the latest revision of the software and BusEngine:

• Select About E2951A/E2952A… in the Help Menu. 

You see this screen:

About E2951A/E2952A… provides the revisions of the used software 
and hardware, for example:

• Analyzer for InfiniBand Software Version

• Analyzer for InfiniBand Firmware and ROM Versions

• BusEngine Version

• Unit Serial Number

NOTE When contacting Agilent Technologies for technical support, please have 
available all the revisions reported in the About E2951 window.
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How to Update the Software Updating the E2951A/E2952A Analyzer for InfiniBand
How to Update the Software

When a new software release is available, it is posted on the Support 
page of the Agilent Technologies Web site at 
www.agilent.com/find/infiniband/ .

To update the software, follow these steps:

1 In the About E2951A/E2952A screen, verify which version of Analyzer 
for InfiniBand software you are currently running.

2 Find the latest released software version on the Agilent Technologies 
website under E2950 Analyzer and Traffic Generator Series for 1x 

InfiniBand.

If you are running the latest version of the software, no further action 
is needed. 

If you are not running the latest version, continue to step 3.

3 Click on the link to download the files for your operating system.

4 Unzip the files into your choice of directory.

5 Click Start, then Run, and browse to where you unzipped the files.

6 Select the program named Setup  and click Open.

7 Click OK to run the Setup and begin the installation.

8 Follow the on-screen instructions to complete the installation.

9 Read the Readme.txt  file for important information on changes in the 
release.
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How to Update BusEngine and 
Firmware

BusEngine and Firmware updates often need to be performed when you 
update the Analyzer for InfiniBand software. These updates can be 
performed automatically or manually. Both processes are described.

Updating the BusEngine and
Firmware

The BusEngine core is the heart of the InfiniBand Analyzer. Using  
Electrically Programmable Logic Device (EPLD) technology, the 
BusEngine incorporates both the high-speed recording engine and the 
configurable building blocks that implement data/state/error detections, 
triggering, capture filtering, external signal monitoring, and event 
counting and sequencing. Both the BusEngine program and the firmware 
that manages the internal microcontroller are fully field updateable.

Within a new software release, it may be necessary to update the 
Analyzer’s BusEngine hardware and/or firmware for proper operation. 
The Readme file that is delivered with the release lets you know if this is 
necessary. 

Automatic Updates
When the Analyzer for InfiniBand’s software is updated, the software 
may become incompatible with the BusEngine and Firmware. If a 
recording is attempted, the Analyzer for InfiniBand will display an error 
message and then automatically begin an update process for the 
BusEngine and Firmware. If you prefer, you can abort this update and 
undertake the steps manually as described later in this chapter.

The steps to perform an automatic BusEngine and Firmware update are:

1 If needed, update the Analyzer for InfiniBand software using the steps 
outlined in ”How to Update the Software” on page 31 described 
above.

2 Turn on the Analyzer.

3 On the toolbar, click the  button.

Since the BusEngine and/or the Firmware are incompatible with the 
current Analyzer for InfiniBand software version, an error message 
will appear displaying your current versions and indicating what 
versions you need to install.
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How to Update BusEngine and Firmware Updating the E2951A/E2952A Analyzer for InfiniBand
4 Click Yes.

The above window closes and the Analyzer Setup window opens.

5 Click Update BusEngine or Update Firmware.

You can select only one item at this point. If both the BusEngine and 
the firmware need to be updated, the update will complete for the first 
item and then return to the above screen so the second update can be 
performed. 
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Updating the E2951A/E2952A Analyzer for InfiniBand How to Update BusEngine and Firmware
Windows 98 If the PC runs under Windows 98®, the following message will tell you 
when the second update is completed.

In this case, power cycle the Analyzer for InfiniBand to complete the 
update.

Windows 2000 and Windows XP If the PC runs under Windows 2000® and Windows XP® the Analyzer 
will automatically reboot and the following message appears. When 
this message appears, click OK.  You do not need to power cycle the 
Analyzer.
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How to Update BusEngine and Firmware Updating the E2951A/E2952A Analyzer for InfiniBand
Manual Updates to BusEngine and 
Firmware
You can manually update Analyzer for InfiniBand’s firmware and/or 
BusEngine by performing the following steps:

1 Select Analyzer under Setup on the menu bar.

You see the Analyzer Setup window:

2 If you need to update the BusEngine, click Update BusEngine.

The Select the engine file to download window opens:

The program has already automatically searched for the correct file 
and displays it in the File name field.

NOTE The most current Primary BusEngine file (ibafpga.rbf ) was copied to 
your E2951A 1x Analyzer for InfiniBand directory when you 
installed the program.

3 Click Open.

4 Power-cycle the Analyzer. Otherwise, continue below.

Re-initialization takes a couple of minutes.
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To update the firmware:

1 Click Update Firmware in the Analyzer Setup window.

The Select the firmware file to download window opens:

The program has already automatically searched for the correct file 
and displays it in the File name field.

2 Click Open.

The Analyzer updates the firmware.

3 For all Windows® operating systems except Windows NT®, unplug the 
USB cable from the back of the Analyzer box and then reinsert it so 
the new firmware update can take effect.

When the USB cable is unplugged and reinserted, the Windows® OS 
automatically checks the connected devices (and thus, downloads the 
drivers for the new firmware).
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Recording the Trace Information

Before recording InfiniBand traffic, make sure the appropriate 
Recording Options have been set. 

Setting the Recording Options

The Recording Options dialog box controls how the Analyzer for 
InfiniBand records InfiniBand data. At the top of the Recording Options 
dialog box are three tabs that provide access to dialog boxes called 
General, Events, and Actions. Using these dialog boxes, you can 
configure the Analyzer for InfiniBand to create event triggers, increase or 
decrease memory allocation for recording, and interact with other 
InfiniBand devices in different ways.
Agilent E2951A/E2952A Analyzer for InfiniBand User Guide, June 2002 37



Recording the Trace Information Setting the Recording Options
Opening the Recording Options Dialog Box
To open the Recording Options menu, click  on the tool bar or select 
Recording Options under Setup on the menu bar.

You see the Recording Options dialog box:

The Recording Options dialog box has three tabs:

• General

• Events

• Actions 

For detailed information about setting the Recording Options please 
refer to ”Windows And Dialog Boxes Reference” on page 81.
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Setting the Recording Options Recording the Trace Information
Saving Recording Options
To complete your Recording Options settings, use the features at the 
bottom of the Recording Options screen. These features remain the same 
no matter which of the three Recording Options screens you are working 
in.

• Click Save to save the currently specified Recording Options for use in 
future recording sessions. Any file name can be specified, though use 
of the .rec  is recommended; if no extension is specified, .rec  is added 
by default.

• Click Load to load a previously saved *.rec  file, thus restoring a 
previous set of Recording Options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.rec . Whenever you start up the 
Analyzer, it automatically loads the default.rec  file if one exists.

• Click OK to apply any changes and close this dialog box.

• Click Cancel to cancel any immediate changes you have made and exit 
the Recording Options menu.
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Recording the Trace Information Recording InfiniBand Traffic
Recording InfiniBand Traffic

To start recording InfiniBand traffic once the appropriate Recording 
Options have been set:

♦ Select Record > Start from the menu bar.

- or -

Click  on the tool bar.

Your recording session can continue until it has finished naturally or you 
may need to stop manually by clicking  on the tool bar, depending on 
how you set the Recording Options.

To manually stop the recording:

♦ Select Record > Stop from the menu bar.

- or -

Click  on the tool bar.

NOTE The manual Stop Recording feature is primarily of use when recording 
low-volume traffic, which can take a long time to fill the recording buffer.

When the recording is finished, the traffic is uploaded to the hard drive 
and then saved as a file named data.ibt  or whatever name you assign as 
the default filename. 

To save a current recording for future reference:

1 Select File > Save As from the menu bar.

- or -

Click  on the tool bar.

You see the standard Save As dialog box.

2 Give the recording a unique name and save it to the appropriate 
directory.
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Recording InfiniBand Traffic Recording the Trace Information
Recording Progress
When you begin recording, the left-most segment of the Status Bar 
displays a Recording Progress Indicator: 

As recording progresses, the Recording Progress Indicator changes to 
reflect the recording progress graphically:

• In the Progress Indicator, a black vertical line illustrates the location 
of the trigger position you selected in Recording Options dialog box. 

• Pre-trigger progress is displayed in the field to the left of the trigger 
position in the before-trigger color specified in the Display Options 
dialog box. 

• When the trigger position is reached, the progress indicator wiggles as 
it waits for the trigger. 

• After the trigger occurs, the field to the right of the trigger position fills 
in the post-trigger color specified in the Display Options dialog box. 

• When recording is complete, the upper half of the progress indicator 
fills in white, indicating the progress of the data upload to the host 
computer.

You should be aware of two exceptional conditions: 

• If a trigger event occurs during the before-trigger recording, the color 
of the before-trigger section changes to the color of the after-trigger 
section to indicate that not all the expected data was recorded in the 
pre-trigger section.

• When you click Stop before or after a trigger event, the Progress Bar 
adjusts accordingly to begin uploading the most recently recorded 
data.

The progress bar reflects the specified size and actual rate at which the 
hardware is writing and reading the recording memory. However, the 
Progress Indicator is normalized to fill the space within the status bar.
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Resolving Reliable Connections
This dialog box allows you to resolve unresolved Reliable Connections 
within the open trace. This dialog box opens automatically after a 
recording if there were any unresolved connections. You can open this 
dialog box at any time by selecting View > Resolve Reliable Connections.

Unresolved reliable connections occur if the recording does not capture 
key events in the traffic – for example, if a device is connected prior to 
beginning the recording. The Resolve Reliable Connections dialog box 
lets you manually assign one half of a connection to another.

You can leave connections unresolved by clicking OK.

Breaking a Connection
To break a connection that you believe is incorrect, select it from the 
center column, then click the Break Connection button.

Creating a Connection
To connect two halves of a connection, select an entry from the Rx 
column, and then select an entry from the Tx column that matches it. If 
the DLID and SLID values match, the Create Connection button is 
enabled. Click the button to make the connection.
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Displaying Real-Time Statistics Recording the Trace Information
Displaying Real-Time Statistics

You can display a graph of link activity.

To display the Real-Time Statistics:

♦ Click  in the tool bar. 

The Real-Time Statistics window opens:

In order to see a graph of traffic, you need to start recording. After 
starting InfiniBand link activity, click  to start the Real-Time 
statistics monitor. 

To stop the monitor, click .

As the traffic is recorded, the data will be streamed in real time to this 
window and presented in the format of your choice. You can select the 
graphs to be displayed in the Real-Time window. Refer to”Working with 

Multiple Graphs in the Real-Time Statistics Window” on page 45 for 
more information.

You can customize the appearance of the Real-Time window. Refer to 
”Customizing the Real-Time Statistics window” on page 44 for more 
information. 

Refer to ”Real-Time Statistics Buttons” on page 46 to get a description 
of the buttons located on the toolbar.
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Recording the Trace Information Displaying Real-Time Statistics
Customizing the Real-Time Statistics 
window
By clicking the  button in the Real-Time Statistics window toolbar, 
a menu shows up, enabling to customize the Real-Time Statistics window 
the following ways:

• Orient Horizontally

Select this command to exchange the (x,y) graph to (y,x). Once done, 
this command becomes Orient Vertically.

• Tile Vertically

Select this command to tile the graphs vertically.

• Show Markers

Select this command to place tick marks along the x axis on each 
graph.

• Status

By selecting this command, a submenu appears enabling to display a 
status bar at the bottom of each graph (Bar command), tooltips 
(Tooltip command) or to hide both the status bar and tooltips (None 
command).

• Grid Lines

Select this command to display only X-axis gridlines, only Y-axis 
gridlines, both or none.

• Grid on Top

Select this command to move the grid lines above the graph.

• Fonts and Colors

Select this command to set the colors and fonts used in the graphs.
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Displaying Real-Time Statistics Recording the Trace Information
Working with Multiple Graphs in the Real-
Time Statistics Window
You have the possibility to display up to three graphs simultaneously.

To work with multiple graphs:

1 Click  in the Real-Time Statistics window. 

The following menu opens:

2 Select the graphs you want to show:

– Statistics accumulation

– Displays the current coordinates and time of the data being 
recorded.

– Link utilization

Plots the percentage of link utilization by non-idle traffic for both 
directions of the link.

– Data Payload Throughput

Plots data payload throughput for both directions of the link.

– Data Packet Count

Plots counts of InfiniBand Data Packets per second for both 
directions of the link.

3 Click the Start button .

Traffic is recorded, the data is plotted directly to the graphs.
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Real-Time Statistics Buttons
The Real-Time Statistics window has a row of buttons for changing the 
format of the displayed data and for exporting data:

The buttons have the following functions:

Save the graphs as a bitmap file (*.bmp) Vertical zoom in

Create an email with a *.bmp file attachment 
of the graphs

Vertical zoom out

Print Click diagonally to select and zoom in on part 
of the graph

Full Screen Select Range

Options for formatting the display.  Refer to 
”Customizing the Real-Time Statistics win-
dow” on page 44 for more information.

If two or more graphs are displayed, syn-
chronize the graphs to one another.  Once 
synchronized, the positioning slider of one 
graph will move the other graphs.

Horizontal zoom in Options for displaying additional graphs of 
data lengths, packet lengths, and percent-
age of bus utilized. Refer to ”Working with 
Multiple Graphs in the Real-Time Statistics 
Window” on page 45 for more information.

Horizontal zoom out
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Specifying the Display of Recorded Trace 
Information

Use the Display Options menu to specify the way InfiniBand Trace 
information is displayed.

To open the Display Options menu:

♦ Select Display Options under Setup on the Menu Bar.

- or -

Click  on the Tool Bar 

You see the Display Options dialog box:
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Specifying the Display of Recorded Trace Information Saving Display Options
The Display Options window always opens with the screen for the 
General tab displayed.

Saving Display Options 

To preserve your Display Options settings for future use: 

• Click Save to save the currently specified Display Options for use in 
future sessions. Any file name can be specified, but you must use the 
.opt  extension. If no extension is specified, .opt  is added by default.

• Click Load to load a previously saved *.opt  file, thus restoring a 
previous set of Display Options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.opt . Whenever you start up the 
analyzer, it automatically loads the default.opt  file if one exists.

• Click OK to apply any changes you have made to Display Options and 
close this dialog box.

• Click Cancel to cancel any immediate changes you have made and exit 
the Display Options menu.

• Click Apply to apply your changes.
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Color Display Options Specifying the Display of Recorded Trace Information
Color Display Options

To adjust the settings for color display:

♦ Click the Colors tab on the Display Options screen.

You see the Colors page:

Use this menu to customize the colors associated with each field in the 
Trace View. You can experiment with this option to achieve the color 
combination best suited to a particular graphic system. A brighter color 
might be appropriate for a specific field that should stand out in the 
display (for example, the Packet Types). 

NOTE The colors of the following packet types cannot be changed:

• Invalid Data (packet error)

• Field (red)

• Softbit Errors (yellow)

Two color fields are provided for packet number displays to differentiate 
between pre-trigger traffic and post-trigger traffic.

• The packet that causes the trigger and all the packets before it are 
colored with the - color. 
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Specifying the Display of Recorded Trace Information Color Display Options
• The packet that follows a trigger is colored with the + color.

• All packets are colored with a + color when there is no trigger.

Use the color buttons labeled + and - under the Packet # section of the 
Colors screen to select a trigger color. 

To select or change a color: 

1 Click the appropriate color button.

You see the color palette: 

Use this palette to choose the desired color for fields within the trace 
such as Routing Headers, Base Transport Headers, CRC, and Packet #.
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Color Display Options Specifying the Display of Recorded Trace Information
2 To select a custom color, click the Custom tab.

The following screen opens:

3 Select the desired color with the mouse.

4 Drag the triangle on the vertical bar to the desired shade. 

5 Click OK to use the color.
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Formats Display Options

The Formats page allows numerical data to be displayed in different 
formats. For example, you can change the format of a field from Hex to 
Binary.

• Click the Formats tab on the Display Options screen.

You see the Formats page:

Click an item to display its current format characteristics and to display 
formatting buttons.  Use the formatting buttons to change the format of 
the selected item.
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Hiding Specifying the Display of Recorded Trace Information
Hiding

Use the Hiding page to hide various fields, packets, messages, and 
protocols from the Trace View screen. You can modify these settings at 
will to display a specific area of a trace.

• Click the Hiding tab on the Display Options screen.

You see the Hiding page:
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Hiding Fields
The Hide Fields check boxes allow individual fields to be hidden within 
a trace. Click the check boxes of your choice to hide one or more fields.

Hiding Packets and Transactions
The Hide Packets and Transactions group contains check boxes for 
hiding packets. 

NOTE Once display options have been set, they can be saved for future use with 
the Save command described in the chapter ”Saving Display Options” 

on page 48.
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Compound Hiding
The Compound Show/Hide command lets you select multiple elements in 
a trace to show or hide. This command is available from the menu bar.

To select which trace elements should be shown or hidden:

1 In the main window, select View > Compound Show/Hide.

A menu opens that shows all the InifiniBand elements in the trace.

This menu remains open while you make your selections. It does not 
close until you click Apply. 

2 Select the type of action that should be performed:

– Hide Checked

The elements that fulfill the selected criteria are hidden in the trace.
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– Show Checked

Only the elements that fulfill the selected criteria are shown in the 
trace, all other elements are hidden.

– Show All

All elements are shown.

NOTE You can turn compound hiding on or off at any point by clicking the 
 button (Apply Compound Hiding) on the toolbar.

There are also special buttons on the toolbar for showing and hiding link 
packets and training sequences:

• To show or hide link packets, click .

• To show or hide training sequences, click .

• To show or hide skip sequences, click .
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Headers

Use the Headers page to define which elements of the various IBA 
Packet Headers are shown on the Trace View Screen. You can change 
these settings at any time so that you can more quickly find the packets 
that are of interest.

• Click the Headers tab on the Display Options screen.

You see the Headers page:

Select any header type in the IPA Packet Header box, and then select 
which fields should be visible when the Packet Header is collapsed.

You can use the Move Up and Move Down buttons to specify the location 
in the Packet Header.
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Reading an Agilent Trace

Here you learn how to easily read and interpret an Agilent trace by using 
the features of the trace view.

Trace View Features

The trace view display shows various information in a very sophisticated 
way:

• The Analyzer for InfiniBand packet view display makes extensive use 
of color and graphics to fully document the captured traffic.

• Packets are shown on separate rows, with their individual fields both 
labeled and color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped (with 
a resolution of 1 symbol time or 4 ns), and highlighted to show the 
transmitted speed (low-speed, full-speed, or high-speed).

• Display formats can be named and saved for later use. 
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Reading an Agilent Trace Tool Tips
• Pop-up tool tips annotate packet fields with detailed information 
about their contents.

• Several fields such as Data fields can be collapsed to occupy minimal 
space in the display. 

• The display software can operate independent of the hardware and so 
can function as a stand-alone Trace Viewer that may be freely 
distributed.

Tool Tips

You can get additional information about each field in a trace by holding 
your mouse pointer over a field. A tool tip will appear with details about 
the field.
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Set Marker Reading an Agilent Trace
Set Marker

NOTE The Set Marker feature works in conjunction with the Go to Marker 
feature.

You can define a unique marker for each packet. 

To place a marker on a packet:

1 Left-click on Packet # for the packet you wish to mark.

You see the Packet menu:

2 Select Set Marker.

You see the Edit Marker Comment window where you can enter a 
unique comment about this packet:

3 Enter your comment. 

4 Click OK.

A marked packet is indicated by a vertical red bar along the left edge 
of the packet # block: 
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Edit or Clear Marker

To clear or edit the comments associated with a packet marker, proceed 
as follows:

1 Left-click on Packet # for the chosen packet.

You see the Packet menu:

2 To edit the Marker Comment:

Select Edit marker.

You see the Edit marker comment window:

3 Edit the comment as desired.

4 Click OK.

To clear a Marker:

5 Click Clear marker.

The vertical red Marker bar disappears.
62 Agilent E2951A/E2952A Analyzer for InfiniBand User Guide, June 2002



Expanded and Collapsed Field Formats Reading an Agilent Trace
Expanded and Collapsed Field 
Formats

Fields that have small triangles in their top left corners can be expanded 
to display greater detail or collapsed to a compact view. There are three 
ways to toggle between the two views. 

Left-clicking the Small Arrows in the Header and Data 
Fields
Some fields have small arrow in their top-left corners that allow the field 
to be expanded or collapsed.

Double-Clicking
You can also expand or collapse a header or data field by double-clicking 
anywhere in the field.

Right-facing 
arrow will 
expand data

Left-facing 
arrow will 
collapse data Expanded data Collapsed data
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Using the Shortcut Menu
If you left-click on a data or header field, a menu will open for expanding 
or collapsing data fields.

1 Left-click on data in the data packet you want to expand or collapse.

If your Data Trace View is currently expanded, you see the Collapse 
Data menu:

If your Data Trace View is currently collapsed, you see the Expand 
Data menu:

Note that you can choose to expand or collapse: 

– Only the Data in the selected Data packet.

- or -

– All Data Fields in the Trace View.

2 Select the desired Expand Data or Collapse Data menu item.

The Trace View is repositioned with the selected packet(s) adjusted in 
the format you have specified.
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Changing the Decoding Assignments for ADP and SRP connections Reading an Agilent Trace
NOTE For headers, the same mechanism works for groups of cells. Vertical 
arrows are used for expanding and collapsing transport functions and 
higher level units. Click and hold applies to collapse and expand actions 
for elements in all views.

Changing the Decoding 
Assignments for ADP and SRP 
connections
You can change the protocol assignments for manually assigned ADP and 
SRP connections:

1 Select View > Decoding Assignments, the Infiniband Connection 
Decoding Assignments dialog box shows up.

2 Select the connection of interest, and then click on Assign to SDP 
(respectively Assign to SRP) to assign the connection to SDP 
(respectively SRP).

3 Click OK.

NOTE When opening trace files that contain unrecognized connections, the 
software automatically opens the Decoding Assignments dialog box.
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Working with Reports

In this chapter you find detailed reference information about the several 
reports that help you analyze InfiniBand traffic recorded by the 
E2951A/E2952A.

Displaying File Information

You can display a File Information report for the current file, providing 
the following information:

• File name

• Comment 

• Number of packets

• Number of the trigger packet

• Version of the software and serial number of the of the analyzer used 
to record the data

• Number of markers

• License information 

• Available features
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To display a File Information report:

• Select File Information under Report in the menu bar.

- or -

Click  in the tool bar.

The File Information screen appears. 
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Displaying the Error Summary

You can display an error summary of the current trace file that allows 
you to go to a specific packet, and save the error file to a uniquely named 
file.

To display an Error Summary report:

1 Select Error Summary under Report in the menu bar

- or -

Click  in the tool bar.

The Error Summary appears below the trace:
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Calculating Timing and 
Bandwidth Parameters

You can display a Timing Calculations report in which you can calculate 
various timing and bandwidth parameters in the recording file. 

To display a Timing Calculations report:

• Select Timing Calculations under Report in the menu bar.

- or -

Click  in the tool bar.

The Timing and Bus Usage calculator dialog box shows up:

To calculate bus usage and bit rate errors: 

1 Enter the range of packets to be examined in the boxes named From 

Packet and To Packet. 

2 Click the Calculate button.

At this point, bus usage will be calculated.
70 Agilent E2951A/E2952A Analyzer for InfiniBand User Guide, June 2002



Displaying the Traffic Summary Working with Reports
Displaying the Traffic Summary

You can display a summary of the types of traffic that occur in the 
current trace file. It also allows you to go to a specific packet.

To display a Traffic Summary report:

1 Select File Information under Report in the menu bar.

- or -

Click  in the tool bar.

The Traffic summary screen appears below the trace:

The left-hand side displays the different protocol levels in tree view. 
When you click the icons with the plus symbol (+), this branch of the tree 
expands.

The right-hand side displays a summary of the traffic for the selected 
level.
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Displaying Parameters of Bus 
Utilization

You can display the Bus Utilization report enabling you to access various 
parameters of bus utilization displayed as graphics. 

To display the Bus Utilization report:

♦ Click  in the tool bar. 

The Bus Utilization report opens:

You can use the Bus Utilization report to evaluate various aspects of the 
bus traffic, for example:

• Packet Count

• Packet Length

• Link Utilization

You can also customize the appearance of the graphs (for example, the 
color) to fit your needs. You can select the graphs to be displayed in the 
Bus Utilization window. Refer to”Working with Multiple Graphs in the 

Bus Utilization Window” on page 74 for more information.

You can customize the appearance of the graph. Refer to ”Customizing 

the Bus Utilization Window” on page 73 for more information. 

Refer to ”Bus Utilization Buttons” on page 76 to get a description of the 
buttons located on the toolbar.
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Customizing the Bus Utilization Window
By clicking the  button in the Bus Utilization window toolbar, a 
menu shows up, enabling to customize the Bus Utilization window the 
following ways:

• Orient Horizontally

Select this command to change the orientation of bus usage to 
horizontal. Once done, this command becomes Orient Vertically.

• Tile Vertically

Select this command to tile the graphs vertically.

• Show Markers

Select this command to place tick marks along the x axis on each 
graph.

• Show Plumb Line

Select this command to display a vertical line enabling to check for the 
alignment of one of the plot data on the different graphs. 

• Status

By selecting this command, a submenu appears enabling to:

– Display a status bar at the bottom of each graph (Bar command), 
showing the coordinates of the cursor on the graph. 

– Display tooltips (Tooltip command). Once selected, place the 
cursor over one of the plot data, a tooltip window appears showing 
the coordinates of the current point.

– Hide both the status bar and tooltips (None command).

• Grid Lines

Select this command to display only X-axis gridlines, only Y-axis 
gridlines, both axes or none.

• Grid on Top

Select this command to move the grid lines above the graph.

• Fonts and Colors

Select this command to set the colors and fonts used in the graphs.
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Working with Multiple Graphs in the Bus 
Utilization Window

Displaying multiple graphs You have the possibility to display up to three graphs simultaneously in 
the Bus Utilization window.

To work with multiple graphs:

1 Click  in the toolbar of the Bus Utilization window. 

The following menu opens:

2 Select the graphs you want to show:

– Link Utilization

Plots the percentage of link utilization by non-idle traffic for both 
directions of the link.

– Data Payload Throughput

Plots data payload throughput for both directions of the link.

– Data Packet Count

Plots counts of InfiniBand Data Packets per second for both 
directions of the link.
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Appending a new graph To append a new graph to the Bus Utilization window:

1 Click  in the toolbar of the Bus Utilization window. 

2 Click New. 

The following dialog box opens. It will display options for setting the 
title, data, color, and line type for the graph.
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Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format 
of the displayed data and for exporting data:

The buttons have the following functions:

Save the graphs as a bitmap file (*.bmp) Vertical zoom in

Create an email with a *.bmp file attachment 
of the graphs

Vertical zoom out

Print Click diagonally to select and zoom in on part 
of the graph

Full Screen Select Range

Options for formatting the display. Refer to 
”Customizing the Bus Utilization Window” on 
page 73 for more information.

If two or more graphs are displayed, syn-
chronize the graphs to one another.  Once 
synchronized, the positioning slider of one 
graph will move the other graphs.

Horizontal zoom in Options for displaying additional graphs of 
data lengths, packet lengths, and percent-
age of bus utilized. Refer to ”Working with 
Multiple Graphs in the Bus Utilization Win-
dow” on page 74 for more information.

Horizontal zoom out
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Exporting InfiniBand Data

The software allows you to export:

• Packets into text files. 

• Data into binary or text files.
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Exporting Packets into Text Files

The software allows you to export packets into text files. The structure 
of the resulting text file reflects the graphical representation of the 
packet in the software. Here is an example of such a text file

Use File>Export>Packets to Text command to export packets into text 
files. The Export Packets/Operation/MADs to Text dialog box opens, 
prompting you to specify a range for the packets.

File D:\Programme\Agilent\E2951A - E2952A Analyzer for
InfiniBand\SampleData4x.iba.

From Packet #1411 to Packet #27776.

Packet#

_______|_______________________________________________________________________

1411___| Tx LRH DLID(0x0002) SLID(0x0003) BTH RDMA WRITE(RC 0A) RETH

________| Virtual Address(0x0000000000000000) Data(30 dwords) ICRC(0xE780365B)

_______| VCRC(0x2D56) Time Stamp(00000.1187 34396)

________|_______________________________________________________________________

1412___| Rx Link FC(normal) FCTBS(0) VL(0x0) FCCL(1103) LPCRC(0x3A2B)

_______| Time Stamp(00000.1187 34584)

________|_______________________________________________________________________

1413___| Rx LRH DLID(0x0003) SLID(0x0002) BTH Acknowledge(RC 11) AETH

_______| ACK(CC 0) MSN(0x000001) ICRC(0x69385884) VCRC(0x56BD)

_______| Time Stamp(00000.1187 34694)

________|_______________________________________________________________________

1414___| Tx Link FC(normal) FCTBS(0) VL(0x3) FCCL(1766) LPCRC(0x257A)

_______| Time Stamp(00000.1187 34954)

________|_______________________________________________________________________

1415___| Tx SKIP COM(K28.5) SKP Symbols(1C 1C 1C)

_______| Time Stamp(00000.1187 35692)

________|_______________________________________________________________________
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Exporting InfiniBand data 

The software allows you to save a part or all of the trace to different 
formats: binary or text. 

Use File>Export>Packets to Text command to export data in DWORD 
format. The Export data dialog box opens, prompting you to specify:

• The packet range

• The format of the file

You can choose to save the data in a binary file (with the DAT 
extension) or in a text file (with the TXT extension).

• The source of data

You can choose between:

– Packet data coming through a given virtual lane.

In this case, you can store data corresponding only to incoming 
packets (Rx), outgoing (Tx) packets or all data transported on both 
directions.

– The Transport function itself

• The maximum size of the file.

If specified, the export process stops when the desired amount of data 
is reached.
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NOTE By default, the resulting file has the following format:

• Data represented as hexadecimal.

• 4 DWORD per line.

• Least Significant Bit order

You can change this default format by selecting ToScreen in the Export 
data dialog box.

The dialog box that opens allows you to choose:

• The format used to represent the data between hexadecimal, decimal, 
ASCII or binary.

• The amount of information per line

• The bit order between Most Significant Bit or Least Significant Bit.

After you have entered this information, click Save Data Block to store 
the data with its settings into a text file.
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Windows And Dialog Boxes Reference

In this chapter you find detailed reference information about the 
Analyzer for InfiniBand’s various software features and options.

Software Overview

To take advantage of the software’s features, it is useful to know about 
its status displays and shortcuts.

The Main Display Menus
While some of the Analyzer for InfiniBand’s main display window 
options are familiar, many contain options specific to the 
E2951A/E2952A program.

Table 1 Main Display Pull-Down Menus

Menu Function

File

Open… Opens a file

Close Closes the current file

Save As… Saves all or a specified range of packets from the current 
file with a specified name

Print… Prints part or all of the current traffic data file

Print Preview Produces an on-screen preview before printing

Print Setup… Sets up your current or new printer

Edit Comment… Creates or edits the Trace file comment field

Export Saves all or part of a trace to different formats: binary or 
text.

Last File Lists the last files that were opened

Exit Exits the Analyzer for InfiniBand program.
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Setup

Display 
Options…

Provides the control of various display options such as 
color, formats, and filters.

Recording 
Options…

Provides setup options for recording, triggering events 
and filtering events.

Analyzer… Allows the operator to reset the E2951A/E2952A or update 
the BusEngine and firmware.

Record

Start Causes the E2951A/E2952A to begin recording InfiniBand 
activity.

Stop Causes the E2951A/E2952A to stop recording.

Disconnect/
Connect

(only available when connected to an E2952A)

Break and then restore the InfiniBand link connection.

Report

File Information Details such information about the recording as number 
of packets and triggering setup.

Error Summary Displays an error summary of the current trace file and al-
lows you to go to a specific packet, and save the error file 
to a uniquely named file.

Timing 
Calculation

Starts the calculator dialog for calculating various timing 
and bandwidth parameters in the recording file.

Traffic Summary Displays a summary of the bus traffic of the current trace 
file, and allows you to go to a specific packet.

Bus Utilization Displays a summary of how the bus was used for the cur-
rent trace file.

Search

Go to trigger Positions the display to show the first packet that follows 
the trigger event.

Go to Packet/  
Operation/
MAD ...

Positions the display to the indicated element.

Go to Marker » Positions the display to a previously marked packet

Go to » Enables quick searching for specific events using a cas-
cade of pop-up windows.

Find This feature allows complex searches. 

Find Next Repeats the previous Find operation. Can also use F3 to 
find next.

Search Direction Allows you to specify a forward or backward search of a 
trace file.

Menu Function
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View

Toolbars Displays list of available toolbars.

Status Bar Switches display of the Status Bar on or off.

Real-Time 
Statistics

Opens a subwindow where the real-time statistics are 
evaluated graphically.

Expand Allows field headers to be expanded.

Collapse Allows field headers to be collapsed.

Show/Hide Allows you to show/hide packets based on the set filter.

Compound 
Show/Hide

Allows you to set several filters for showing and hiding 
packets.

Zoom In Zoom in increases the size of the displayed elements.

Zoom Out Zoom out decreases the size of the displayed elements.

Wrap Allows the display to wrap.

Decoding As-
signments

Lets you create or edit protocol assignments to connec-
tions.

Resolve Reliable 
Connections

Lets you resolve reliable assignments within the open 
trace.

Packets Level View packet level.

Transport Func-
tions Level

View/Hide Transports Functions Level.

MADs Level View/Hide MADs Level.

SADM Level View/Hide Subnet Administration Level. 

SDP Level View/Hide Sockets Direct Protocol Level. 

Window

New Window Switches display of the Tool Bar on or off.

Cascade Displays all open windows in an overlapping arrange-
ment.

Tile Displays all open windows in a side-by-side arrangement.

Arrange Icons Arranges minimized windows at the bottom of the display.

Windows Displays a list of open windows.

Help

Help Topics Displays online help.

About Analyzer 
for InfiniBand

Displays version information about Analyzer for Infini-
Band.

Menu Function
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View Options
You can hide, display or reset toolbars by selecting View > Toolbars from 
the menu bar.

Toolbar

The toolbar provides access to the most popular program functions. Tool 
tips describe icon functionality as the mouse arrow is moved over the 
icon/item.

Resetting the Toolbar From time to time (such as following a software upgrade) it is possible 
that the buttons on the tool bar will no longer match their intended 
function. 

To reset the toolbar:

1 Select View > Toolbars from the menu bar.

2 Select Customize from the sub-menu.

The following dialog box opens:
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3 Select the Toolbars tab.

The following dialog box opens:

4 Click the Reset All button.

The factory defaults are reset.

Toolbar icons The following icons are available in the default toolbar:

Open file Apply Compound Hiding

Save As Find 

Preview Find Next

Print… File Information Report

Setup Record Options Error Summary

Setup Display Options Timing Calculations

Start Recording Traffic Summary

Stop Recording Bus Utilization
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The Status Bar
The Status Bar is located at the bottom of the main display window. 
Depending on the current activity, the bar can be divided into as many as 
four segments.

Recording Status
During recording activity, the current Recording Status is temporarily 
displayed in the next segment. When you activate the Record function, 
this segment flashes one of the following messages (depending on the 
selected Recording Options):

• Trigger?

• Triggered!

• Uploading

After the recording stops, 

• the flashing message changes to Uploading data–x% done (x% 
indicates the percentage completion of the data uploading process). 

• the traffic data is copied to disk (overwriting any previous version of 
this file) using the default file name data.ibt  or a new name specified 
in the Recording options.

Break and then restore the 
link 
(only available for the 
E2952A)

Real-Time Statistics

Zoom In View Packet Level

Zoom Out View Transport Functions 
Level

Wrap View MAD Level

Hide Link Packets View/Hide Subnet Administra-
tion Level

Hide Training Sequences View/Hide Sockets Direct Pro-
tocol Level

Hide/View SKIP sequences
(only available for data re-
corded with the E2952A)

View/Hide SCSI RDMA Level
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To abort the upload process:

♦ Press Esc on your keyboard.

- or -

Click  in the toolbar. 

You are prompted to choose whether to keep the partially uploaded 
data or to throw it away.

When the data is saved, the Recorded Data file appears in the main 
display window and the Recording Status window is cleared. 

• If the recording resulted from a trigger event, the first packet 
following the trigger (or the packet that caused the trigger) is initially 
positioned second from the top of the display.

• If the recording did not result from a trigger event, the display begins 
with the first packet in the traffic file.

Analyzer Status
The third segment in the status bar displays the analyzer status. During 
uploading, this segment displays the percent of the upload process 
completed.

NOTE If packets are filtered from the recording or data are truncated, the 
recording activity is reduced.

Search Status
The rightmost segment displays the current search direction: Fwd 
(forward) or Bwd (backward).

Zoom In
Zoom In increases the size of the displayed elements, allowing fewer (but 
larger) packet fields per screen. 

Click  on the tool bar.

Zoom Out
Zoom Out decreases the size of the displayed elements, allowing more 
(but smaller) packet fields per screen. 

Click  on the tool bar.
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Tool Tips
Throughout the application, tool tips provide useful information. 

To display a tool tip, position the mouse pointer over an item. The tool tip 
displays in a short moment if present. Tool tips can also be found over 
the Tool Bar and in areas of the packet view screen. 

Analyzer for InfiniBand Keyboard Shortcuts
Several frequently-used operations are bound to keyboard shortcuts. 

Table 2 Keyboard Shortcuts

Key Combination Operation

Ctrl+C Copy

Ctrl+Insert Copy

Shift+Del Cut

Ctrl+X Cut

Ctrl+V Paste

Shift+Insert Paste

Ctrl+Z Undo

Alt+Backspace Undo

Ctrl+O Open the file

Ctrl+S Save the file

Ctrl+Home Jump to first packet

F3 Find Next

Ctrl+B Search Backward

Ctrl+F Search Forward
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General Display Options

Use the General Display Options to specify the basic appearance of a 
Trace View. You open the Display Options dialog box by selecting 
Setup > Display Options.

• Zoom Level

Adjustable in discrete increments from 10% to 200% percent.

• Enable Tips

Select to enable tool tips with explanation text to pop up when you 
position your cursor over various fields in the Trace View.

• Wrap

Inhibits carriage returns in packets when they exceed the width of the 
window.
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• Trace Viewing Level

Allows the trace to be displayed in different hierarchical levels:  
Packet, Transport Functions, Management Datagrams, Subnet 
Administration, Sockets Direct Protocol, SCSI RDMA Protocol.

• Idle Time Presentation 

Causes the E2951A/E2952A Analyzer for InfiniBand to display Idle 
Time in one of two formats:

– Show Idle Time

– Show Idle in Symbol Time (1 symbol = 4ns)

• Point of View

Allows you to swap the transmit and receive directions in a trace 
(packets labeled as Transmit will become labeled as Receive and vice 
versa): 

– Swap Tx/Rx

NOTE Swapping is also allowed in the Tx/Rx cell in the Trace view.

• Fonts

– Fields: Lets you define the appearance of field text.

– Data: Lets you define the appearance of data text.

• Display Configuration Name 

A Comment field associated with the *.opt  file containing the current 
Display Options values. You can also create and store your unique 
Display Options for future use.
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Recording Options

This section shows you how to adjust the recording options to match 
your special recording needs (for example, determining which and how 
data is recorded).

Recording Options - General
The General tab is made up of boxes marked Recording Type, Buffer 

Size, Trigger Position, and Options.
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Recording Type
The Recording Type box presents three options that allow you to set how 
the Analyzer for InfiniBand begins and ends a recording. The options are: 
Snapshot, Manual Trigger, and Event Trigger.

Snapshot A Snapshot is a fixed-length recording whose size is determined by the 
Buffer Size group in the Recording Options dialog box or by a manual 
click of the Stop button. 

Recording begins by clicking  on the Tool Bar and ends when either 
the selected buffer size is filled or you press the Stop button.

Manual Trigger A Manual Trigger recording is a one that is manually begun and ended. 
Recording is begun by pressing  on the Tool Bar. 

Recording continues in a circular manner within the limits set by the 
buffer size. 

Recording ends when   is clicked on the Tool Bar or the Trigger 
button is pressed on the Analyzer for InfiniBand's front panel. If you 
press the Trigger button, recording will continue until the post-trigger 
memory has been filled.

Event Trigger An Event Trigger recording is one that uses an event trigger to end the 
recording. Before recording begins, you define the event trigger in the 
Events Recording Options dialog box (accessible by selecting Setup > 

Recording Options > Events from the menu). 

You begin the recording by clicking  on the Tool Bar. 

Recording continues in a circular manner within the limits set by the 
buffer size. Once the trigger event occurs, some post-trigger recording 
occurs, then the recording ends.

NOTE In this mode, the recording can be stopped manually in the same way as 
for Manual Trigger mode.
92 Agilent E2951A/E2952A Analyzer for InfiniBand User Guide, June 2002



Recording Options Windows And Dialog Boxes Reference
Options
The Options group contains the following options:

Beep When Trigger Occurs Will cause the PC to beep when a trigger event has occurred.

Save External Interface Signals When this option is selected, the Analyzer saves external interface 
signals from a break-out board as fields in the trace.

Collect File Information on Uploading When recording InfiniBand data, the software performs several 
operations after each packet is uploaded from the E2951A/E2952A to the 
host PC. These operations consist of decoding higher protocols and 
summarizing the traffic in various report windows. They can become 
time-expensive when recording a large amount on InfiniBand data.

To save time, clear this option. The software will then perform these 
operations when displaying these data on screen.

Inhibit Allows you to block the E2951A/E2952A’s reception of transmit and/or 
receive link activity. When a direction is inhibited, none of the other 
recording events will be detected.
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Buffer Size
The Buffer Size group has a slide bar for adjusting the recording buffer 
size from:

• 0.4MB to 512MB if the E2951A is connected

• 1.6 MB to 2048 MB if the E2952A is connected

NOTE The scale is not linear; there is more granularity in smaller buffer sizes. 

The Recording Type option determines how this buffer is used. Although 
there are 512 MB of physical memory in the E2951A/E2952A, the 
efficiency of the recording ranges from 2:1 to 4:1 ratios of physical 
memory to actual InfiniBand traffic. Shorter InfiniBand packets yield a 
less efficient recording. The non-traffic portion of physical memory is 
utilized for control and timing information.

Trigger Position
The Trigger Position slide bar sets the amount of post-trigger recording 
that the Analyzer for InfiniBand will perform. It also allows adjustment 
of the location of the trigger within the defined buffer. 

You can adjust the Trigger Position between 1 and 99% post-trigger. 
Trigger Position is available only when Manual Trigger or Event 

Trigger is selected as Recording type.

As an example, if the buffer size is set to 16 MB, then for the following 
Trigger Position settings, the amount of pre- and post-trigger data is

95% post-triggering 0.8 MB pre-trigger 15.2 MB post-trigger

75% post-triggering 4 MB pre-trigger 12 MB post-trigger

50% post-triggering 8 MB pre-trigger 8 MB post-trigger

25% post-triggering 12 MB pre-trigger 4 MB post-trigger

5% post-triggering 15.2 MB pre-trigger 0.8 MB post-trigger
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NOTE You can use the external input and external output connectors on the 
rear of the Analyzer as triggers. This lets you daisy-chain the Analyzer 
into a test environment.

The external input is always on, and is edge-sensitive.

NOTE When a trigger occurs, recording continues until the post-trigger amount 
of the buffer is filled.

Recording Options - Events
If you have selected the Event Trigger mode under the General tab in the 
Recording Options dialog box, you may now select specific InfiniBand 
events using the Events tab on the Recording Options dialog box. You 
can also use the Actions tab to define specific event sequences that will 
trigger the Analyzer for InfiniBand to record a InfiniBand session. 

In addition, the Events and Actions pages allow you to specify which 
packets you want to include or exclude from the recording.

NOTE The choices you make on the Events page may cause other events to 
become unavailable for additional triggering or filtering. For example, if 
you select a Syndromes option and then open the AETH options 
window, you will see that a set of AETH check boxes are unavailable.
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Events Options
To see the Events page: 

♦ Click the Events tab on the Recording Options dialog box.

The Events page allows you to set event conditions for errors and/or a 
variety of packet characteristics. Its contents change with the analyzer in 
use.

Clicking a check box causes further options to be displayed in the right 
side of the window.
96 Agilent E2951A/E2952A Analyzer for InfiniBand User Guide, June 2002



Recording Options Windows And Dialog Boxes Reference
VLs & LIDs (only available when using the E2951A)

Clicking VLs & LIDs opens three sets of check boxes and menus on the 
right side of the window.

The abbrevations have the following meanings:

• VL (Virtual Lane)

The VL drop-down menu presents a list of Virtual Lanes. Select a VL to 
trigger or filter on it.

• DLID (Destination Local Identifier)

Enter a DLID into the text box if you want to trigger or filter on DLID.

• SLID (Source Local Identifier)

Enter a SLID into the text box if you want to trigger or filter on SLID.
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OpCodes & QPs (only available when using the E2951A)

Clicking OpCodes & QPs opens three sets of check boxes and menus on 
the right that represent Packet OpCodes and destination Queue Pairs.
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Syndromes (only available when using the E2951A)

Clicking Syndromes opens three drop-down menus that allow you to set 
triggers or filters on ACK or NAK Syndromes.
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Errors Clicking Errors causes check boxes to appear for setting conditions for 
triggering based on packet/signaling/protocol errors. You can select one 
or a combination of errors.
100 Agilent E2951A/E2952A Analyzer for InfiniBand User Guide, June 2002



Recording Options Windows And Dialog Boxes Reference
LRH Pattern (only available when using the E2951A)

LRH Pattern presents options for setting triggering and/or filtering on 
Local Route Headers. You can select one or a combination of up to three 
LRHs.  The Edit button open pattern editors for setting bit-by-bit 
patterns.

LTH Pattern Editor If you click one of the Edit buttons, a pattern editor box will open similar 
to the one shown below that will allow you to set bit-by-bit pattern.
Agilent E2951A/E2952A Analyzer for InfiniBand User Guide, June 2002 101



Windows And Dialog Boxes Reference Recording Options
BTH Pattern (only available when using the E2951A)

Clicking AETH Pattern causes check boxes and editing buttons to 
appear on the right for setting triggering and/or filtering on Ack 
Extended Transport Headers. You can select one or a combination of up 
to three BTHs.

If you click one of the Edit buttons, a pattern editor box opens similar to 
the one shown in ”LTH Pattern Editor” on page 101, which allows you 
to edit up to three bit-by-bit patterns.
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AETH Pattern (only available when using the E2951A)

Clicking AETH Pattern causes check boxes and editing buttons to 
appear on the right for setting triggering and/or filtering on Ack 
Extended Transport Headers. You can select one or a combination of up 
to three AETHs.

If you click one of the Edit buttons, a pattern editor box will open similar 
to the one shown in”LTH Pattern Editor” on page 101, which allows you 
to edit a bit-by-bit pattern.
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ImmDt Pattern Clicking ImmDt Pattern causes a check box and edit button to appear 
on the right for setting triggering and/or filtering on Immediate Data 
Headers. You can select one or a combination of up to three ImmDt 
patterns.

Select Use if you want to use your pattern for triggering/filtering.

If you click one of the Edit buttons, a pattern editor box opens similar to 
the one shown in ”LTH Pattern Editor” on page 101, which allows you 
to edit up to three bit-by-bit patterns.
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MAD Pattern Clicking MAD Pattern causes a check box and edit button to appear on 
the right for setting triggering and/or filtering on Management Datagram 
fields.

If you click one of the Edit buttons, a pattern editor box opens similar to 
the one shown in ”LTH Pattern Editor” on page 101, which allows you 
to set a bit-by-bit pattern.
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Data Pattern Clicking Data Pattern causes an edit field and button to appear on the 
right for setting data patterns for triggering.
106 Agilent E2951A/E2952A Analyzer for InfiniBand User Guide, June 2002



Recording Options Windows And Dialog Boxes Reference
If you click the Edit button, a Data Editor box will open that allows you 
to set up to eight bit-by-bit patterns that will be used as triggers.
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Breakout Board Data Clicking Breakout Board Data causes a pattern editor to appear on the 
right for setting triggering and/or filtering on Breakout board data. The 
pattern editor allows you to edit a bit-by-bit pattern.
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Special Trigger Clicking Special Trigger causes check boxes to appear on the right for 
setting triggers on special types of events such as Data Packets and Link 
Packets. You can select one or a combination of events.
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Special Filter Clicking Special Filter causes check boxes to appear on the right for 
setting filters on special types of events such as Data Packets and Link 
Packets. You can select one or a combination of events.

Header Fields (only available when using the E2952A)

This option enables to set up header parameters for triggering or 
filtering.

Header Patterns (only available when using the E2952A)

This option enables to set pattern matchers for every possible InfiniBand 
header type.

For each header type, select Use and then click the Edit button to edit 
the pattern matcher of interest.

Following topics provide detailed information about some of the pattern 
matchers:

• ”LRH Pattern” on page 101

• ”BTH Pattern” on page 102

• ”AETH Pattern” on page 103
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Recording Options - Actions 
The Actions page allows you to specify the type of action that occurs 
when the Analyzer for InfiniBand encounters the events you selected on 
the Events page.

Actions Page Layout 
Events appear as buttons on the left side. Event buttons are connected 
by lines to Action buttons.  The lines indicates the actions that will occur 
when the events take place in the trace. By default, events are linked to 
the Trigger, meaning that the Analyzer will trigger when the events 
occur. 

Filter Out, Filter In and Restart provide alternative actions that can be 
performed. 

Count1 and Count2 provide a mechanism for counting events. This 
allows you to set a trigger that occurs after a specific number of events 
have occurred.

Trigger causes the Analyzer to trigger when an event occurs.

Action buttons

Event buttons

Counter buttons
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Filter In and Filter Out do what their names imply: They filter in or filter 
out traffic from the trace. If you filter out traffic, you prevent it from 
being recorded. If you filter in traffic, you allow only the chosen traffic to 
be preserved in the trace. Filtering affects the recording process itself -- 
if you filter out traffic, for instance, it will not be preserved in the trace.

Restart causes Event Sequencing to restart. Event sequencing is the 
process of triggering or filtering on multiple events.  To  understand how 
this button works, we need to further examine sequencing. 

Event Sequencing
You can set up the Analyzer to trigger when various events occur in the 
trace. You can even set up sequences of events that have to occur before 
the Analyzer is triggered. There are two types of event sequences: AND 
and OR sequences.

AND sequences If Events are strung together into a series, as shown below, the Analyzer 
will trigger or filter when it sees this sequence.  Such a sequence can be 
thought of as an AND sequence: “Perform an action when x and y occur.”

NOTE Not all events can be sequenced together. For example, you cannot 
sequence a MAD pattern with an AETH packet.
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OR sequences If Events are connected to Actions by parallel lines, an OR sequence is 
created: “Perform an action when either x or y occurs.” The following 
graphic gives an example. 

 

Restarting a Sequence with the Restart Button
The Restart button provides you with a way to restart the sequencing 
process when a key event occurs, such as an error.  The screenshot 
below gives an example.  It shows the Analyzer looking for a sequence of 
LRH VL&LID packets but restarting the search if an error is encountered.
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Connecting Events to Actions
To change the current associations between Events and Actions, you 
click an Event button and then an Action button. When you click on the 
Event button, an elastic arrow will appear on the mouse pointer.  When 
you click the Action button, the arrow will anchor itself to the Action 
button and change into a line. 

The steps are as follows:

1 Click the left mouse button on an event button such as LRH. The 
elastic arrow appears:

2 Drag the arrow to the desired Action button.

3 With the pointer over an Action button, click again the left mouse 
button again.

The arrow is replaced with a black line connecting the Event button 
to the Action button.

Enabling External General Purpose Output
This option makes it possible to send an external output signal when a 
triggering event occurs. The following steps are outlined in order to 
explain the pop-up menu that occurs when you open a blue dot pop-up 
menu on an Event button.
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To enable or disable external trigger output:

1 Click the blue dot on an Event button such as LRH.

A menu similar to the one below will open. Your menu may say 
Disable instead of Enable.

2 Select Enable External Trigger Output (or Disable External Trigger 

Output if that is the choice presented).

If you have chosen Enable External Trigger Output, a small arrow 
will appear on the right side of the button.

This arrow indicates that a condition has been set for creating an 
external output signal. Choosing Disable External Trigger will cause 
the arrow to disappear.

3 Choose External Trigger Form.

A menu will appear with choices for Pulse Low, Pulse High and 
Toggle.

4 Choose an option not currently selected.

The menu closes.

5 Reopen the menu.

Note that your new selection is now checked.
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Other Features

Here you find some features that help you to navigate through your data 
trace and to filter and sort it by events and data types.

Search
The Search feature provides several options for searching through 
recorded traffic, allowing you to find specific packets based on triggering 
status, packet number, marking, or content. 

To view the Search options:

♦ Click Search in the menu bar.

You see the Search drop-down menu:

Go to Trigger
To display a triggering event, select Go to Trigger under Search on the 
menu bar. The Trace Viewer display will reposition the trace to show the 
triggering event at the top of the screen.
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Go to Packet/Operation/MAD...
To display a specific packet, operation or MAD:

1 Select Go to Packet/Operation/MAD... under Search on the menu bar.

You see the Go to Packet/Operation/MAD dialog box:

2 Select the type of element you want to display from the drop-down 
list.

3 Do one of the following:

– Enter the number of the element you want to display.

– Select a value from the drop-down list.

4 Click OK.

The trace is repositioned to show the packet at the top of your screen.

Go to Marker
To instruct the E2951A/E2952A to display a marked packet:

1 Select Go to Marker under Search on the menu bar.

You see a menu listing the marked packets in that Trace View:

2 Select the desired packet from the displayed list.

The Trace repositions to show the packet at the top of your screen.
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NOTE The Go to Marker feature functions in conjunction with the Set Marker 
feature. The comments within the parentheses following each marked 
packet are added or edited with the Set Marker feature. 

Go To
The Go To feature takes you directly to an event in a trace.

To use the Go To feature:

1 Select Go To under Search on the menu bar.

You see the Go To drop-down menu:

2 Select the event you want to go to. 

This opens up additional menus, where you can specify exactly the 
event you want to go to.

Find
The Find feature allows searches to be conducted on an open trace using 
one or more criteria.  You can search by packet, transactions, split 
transaction, transfer, by packet type and by fields within packets.  

Find is run by selecting Search > Find or by clicking on the toolbar.  

Searches can combine criteria using the options Intersection and Union.  
Intersection creates AND statements such as “Find all packets with x 
and y.” Union creates OR statements such as “Find all packets with x OR 
y.”

You can also perform searches whereby packets or events are excluded 
from a trace. Exclusion allows searches to be conducted.
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To perform a search:

1 Select Find... under Search on the menu bar.

- or -

Click  in the Tool Bar.

The Find dialog box opens:

2 Select Packet, Transaction, Split Transaction, or Transfer from the 
top left list box.

Your choice will affect options presented in the Events Group box.

3 Select one or more events from the Events Group list.
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4 Select one of the following options:

5 If desired, select the following:

– Direction and Origin to determine where and in which direction 
the search starts

– Find All to find all instances of an event group

– Search in Hidden to also find hidden event groups

6 Click OK.

After the search finishes, the packets meeting the search criteria are 
displayed.

Find Next
To apply the previous Find parameters to the next search:

• Select Find Next under Search on the menu bar.

- or -

Click  on the Tool Bar.

Option Icon Description

Union Find all packets matching ANY of the specified 
events.

Intersection Find all packets matching ALL of the specified 
events. 

Exclusion Exclude packets matching any of the specified 
events. 

Exclusion works with the other two options. You 
select Union AND Exclusion to exclude packets 
with ANY of the selected fields; or Intersection 
AND Exclusion to exclude packets with ALL of the 
selected fields.
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Display Raw 10b Code
To view Raw 10b Codes, left-click on the first cell in a packet and select 
Show Raw 10b Codes from the pop-up menu shown on the right.

After you have made your selection, the following window opens:

Edit Comment
You can create, view, or edit the 100-character comment field associated 
with each Trace file.

1 Select Edit Comment under File on the menu bar.

You see the Edit comment for trace file window:

2 Create, view, or edit the comment.

3 Click OK.
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Specifications

The following specifications describe the E2951A/E2952A Analyzer for 
InfiniBand. 

Operating Characteristics

Probing Characteristics

Recording Memory Size 
E2951A: 512 M x 8-bit DRAM for traffic data capture, timing, state and 
other data.

E2952A: 2048 M x 8-bit DRAM for traffic data capture, timing, state and 
other data.

Basic Trigger Events
The E2951A/E2952A Analyzer for InfiniBand can be triggered by errors, 
packet-oriented events, or other conditions. See ”Recording Options” on 

page 91 for more information.

Connection: E2951A: HSSDC2 receptacles

E2952A: MicroGigaCN receptacles 

Standard InfiniBand cables

Host connection (USB 2.0, type "B") 
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Specifications Certification
Certification 

Environmental Conditions

Condition Value Range

Overvoltage/Insulation category II

Pollution Degree 2

CTI Index III

Altitude up to 2000m

Manual Operating Temperature 0 to 40°
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Certification Specifications
Declaration of Conformity
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Power Requirements

WARNING Refer servicing to qualified service personnel only.

Power: 100 - 240 V ~ / 50 - 60 Hz / 100 VA max

Fuse of the ASTEC Adapter NTQ123:

• Ref. Des.: F1

• Type: F 4A 250V

Power Cable
In accordance with international safety standards, this instrument is 
equipped with a three-wire power cable. The figure below shows the part 
numbers of the power cables available. When connected to an 
appropriate AC power receptacle, this cable grounds the instrument 
cabinet.

Denmark
8120-2956

Europe
8120-1689

Great Britain
8120-1351

L

E

N

N L
L N

E

E

Australia
8120-1369

L

E

N

South Africa
8120-4211

NL

E

Switzerland
8120-2104

LN
E

E

L N

United States  120V
8120-1378

E

L N

Japan 120V
8120-4753
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